Intro to Scripting part 1, 2, 3
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Functions Colors Unity Components
Syntax Materials Particle component
Arithmetic operators  Inferaction Parenting

If statement -button input KeyCode

-key input Prefalbs
Instantiate
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Project Assets

Assets are the models, textures, sounds and all other media files from
which you make your 3D project

— Audio Files
— Materials
— Meshes

— Textures

— Prefalbs

— Scripts

— Prefalbs
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Project Organization

Project > Create >Folder

- Layers ~ || Layout -

Main Camera

Cube
Directional light @ o
Plane i

top_cube
QuiScript

3 bullets
W scenes

|_scr
W Standard Assets
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Project Organization

Asse'l's > Folder > El Console 3 Project =
Create ~ 4%
Favorites Assels
All Materials € bullets
Ren(]me All Models W materials
All Prefabs i scenes
. All Scripts W scripts
Mafterials - W sounds
. Yl am Standard Assets
SC”pTS @ materials -
i sCenes
Scenes B scripts
) sounds
PrefCI bS s Standard Assets
Textures LIRSS

Sounds
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Project Organization

- Keep your assets organized

« Be consistent with naming. If you decide to use camel case for
directory names and low letters for assets, stick to that convention.

« Use lowercase folder names
« Use camelCase naming convention if needed
« Sort all the assets in the corresponding folders
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Project Organization

« Do not store any asset files in the root directory. Use subdirectories
whenever possible.

« Do not create any additional directories in the root directory,
unless you really need to.

« Use 3rd-Party to store assets imported from the Asset Store. They

usually have their own structure that shouldn’t be altered.
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Project Organization

3rd-Party Resources
Animations Textures
Audio Sandbox

— Music Scenes

— SFX — Levels
Materials — Other
Models Scripfts
Plugins — Editor
Prefabs Shaders
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Unity Components

Components are the nuts & bolts of objects and behaviors in a
game.

A GameQObject is a container for many different Components.
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Unity Components

Animation components Mesh components
Asset components Network group
Audio components Particle components
Physics components Rendering components
The GameObject Transform component
Image effect scripts UnityGUI group
Settings managers Wizards
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Unity Components

Audio components
Implement sound in Unity
— Audio Listener
Add this to a Camera to get 3D positional sound.
— Audio Source

Add this Component to a GameObject to make it play a
sound

— Audio Effects
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Unity Components

The Game Object

GameObjects are containers for all other Components
All objects in your scene are inherently GameQObijects

They are containers that hold Components, which implement
actual functionality. Ex. a Light is a Component which is
aftached to a GameObject.
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Unity Components

Mesh components

3D Meshes are the main graphics primitive of Unity

Various components exist in Unity to render regular or skinned
meshes, trails or 3D lines

Mesh Filter
Mesh Renderer

Skinned Mesh Renderer
Text Mesh
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Unity Components

Particle components

Partficle Systems are used to make effects
Smoke

Steam

Fire

Atmospheric effects

Particle systems in Unity work by using one or two textures (2D), and
drawing them many times, creating a chaotic random effect
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Unity Components

Particle components

Transform

v Ellipsold Par

Ellipsoid Particle Emitter [
Line Renderer |
Mesh Particle Emitter
Particle Animator )
Particle Renderer s R - Troncr vecn
Trail Renderer > == |

Particle Collider
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Unity Components

Particle components

Ellipsoid Particle Emitter
spawns particles inside a sphere
Use the Ellipsoid property to scale & stretch the sphere
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Unity Components

Particle components
Line Renderer

draws a straight line between two or more points in 3D space

can be used to draw anything from a S|mple straight line, to a
complex spiral

renders billooard lines that have width
and can be textured

uses the same algorithm for line rendering
as the Trail Renderer
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Unity Components

Particle components
Trail Renderer

makes trails behind moving objects in the scene

P B i = "
T — ;&_b-_‘ F—_—_‘ - | o r— ‘d_f.l o
— ":*‘——u#—__. ’ ! S J*__F‘_,J%,_.a—-—‘
e ,_T_ e — ‘
_J T 13——_4—1_" ——

CS / DES Creative Coding



Unity Components

Particle components
Particle animator

Move particles over time
Used to apply wind, drag and color cycling to particle systems
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Unity Components

Particle components
Mesh particle emitter

emits particles around a mesh
particles are spawned from the surface of the mesh
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Unity File Edit Assets JeElytlolJ-la@ Component Mo

Particle component | Create Empty 0 %N
am m’u 0~ % [fs1| [ Create Empty Child 4N
. _I_t”'. ’ ROYE Object >
Open your Unity scene =Lt | 2D Object > |
GameObject >Particle Systen [——w—m"ms ;'gg,t ‘
Directional Light SR
. oy Plane Ul . P
Rename it “Confett Cube
Cylinder Camera
Move To View \ 38F
Align With View 1+ 38F

Align View to Selected
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© |nspector o
(M [Particle System |Static «
. v’ | |Particle System !
Particle com ponen’r foe e :
¥ .~ Transform & =
Position X 0 Y 1.100233/Z 0
Rotation X 270 yo  |zlo ’
Scale X1 Yil1 Z|1
. .
Particle Effect window / Inspector K9 i e
Open Editor...
= v . - o - (PEEY Particle Syst ]
2 . . . . “ article System
® Unity File Edit Assets GameObject Component Window Help m *
- ﬁmﬂ Duration 5.00
Particle Effect o Looping v
Pause Stop Show: All Resimulate | Wireframe Prewarm
- — = Start Delay 0 v
Start Color v & Start Lifetime 2 v
Cravity Modifier 0 2 Start Speed 2 v
Simulation Space Local & Start Size 2 z
Scaling Mode Shape : S G R
ol _ ket 7 Start Rotation 0 v
Play On Awake Randomize Rotation Direc 0
‘Mfm Farticles 1000 Start Color v
+ Emission Cravity Modifier 0
‘— St Simulation Space Local
: p T Scaling Mode Shape
Velocity over Lifetime Play On Awake* Vi
Limit Velocity over Lifetime Max Particles 1000
Inherit Velocity |V Emission |
 Force over Lifetime ‘f‘lsm"' 4
: — | Velocity over Lifetime
+ Color over Lifetime 5 : 4
|  Limit Velocity aver Lifetime
7 Color II] x ;Inhenl\lelomy
‘“ Colar by Speed . — | Force over Lifetime
. § ¥
, Ao T v Color over Lifetime - . —
. Col ‘ v
Size by Speed Rl = = = o
= = | Color by Speed }
Rotation over Lifetime :lsm over Lifetime
Rotation by Speed | Size by Speed )
External Forces | Rotation over Lifetime )
Collision : Rotation by Speed
Sub Emitters o |  External Forces }
- = - L Collision J
Texture Sheet Animation - A [ Sub Emitters :
4L CO m p ute r | Texture Sheet Animation

§
v Renderer



Particle Script - confetii

public class confetti : MonoBehaviour {

public ParticleSystem confettiEmitter;
void Start () {

}
void Update () {

if (Input.GetButtonDown("Fire1"))

{
confettiEmitter.Emit(30);
}
}
}
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© Inspector -
Position X122 Y 1.147563 Z 0.2

Rotation X -7.48691< Y 0 Z0

Particle component e

Cylinder (Mesh Filter) & &
Mesh Wi Cylinder g

o M Capsule Collider @ %

| £ | Edit Collider

Assign “ParticleScript” to a cylinder e L

Material None (Physic Material) Q

Center X0 Y 0 z0
(drag and drop)
Height 2
Direction
[¥ Mesh Renderer
Cast Shadows [
M M M Receive Shadows 4
Assign Confetti Particles to v
Use Light Probes 4
Reflection Probes Blend Probes

Confeftti Emitter variable in the Inspector
(drag and drop from Hierarchy) i

Uncheck “Play on Awake” box in the Inspector i =s

Uncheck “Looping” box

Js| [ Particle Script (Script)

With selected Confetti object in Hierarchy

y cylinderMaterial

acy Shaders/Transparent/Diffuse

CS / DES Creative Coding Computer S v rr— '



(OFX S = Bl [=center| ocal |

particles.unity - unity2 - PC, Mac & Linux Standalone (Personal) <OpenGL 4.1>

© Inspector

Lo J {Account - ] [Lavers - | [ avout

= Hierarchy | ; ## Scene . - - :
| Create | (oAl <) | & 7| Gizmos +| AT ) Position Xi2.2 [¥]15 z02
» FPSController Rotation X 0 Yo z0
Directional Light Scale X1 |¥11.147563 Z |1
2‘::: ¥ Cylinder (Mesh Filter) @ #,
Cylinder et lggy__ly_\der —I &
Confetti ¥ | ¥ Capsule Collider @ %,
Edit Collider
Is Trigger .
Material |None (Physic Material) | o
Center X0 Y0 'z o
Radius 0.5
Height 2
Direction | Y-Axis ¢
¥ .. ¥ Mesh Renderer Q%
Cast Shadows |.on sl
Receive Shadows
» Materials
Use Light Probes
Reflection Probes | Blend Probes ™
Anchor Override |None (Transform) i)
. = Bcomsole v S ¥ s Forcx S et it
i Create * ’Q—\ | Clear ‘ lColllau | Clear on Play | Error Pause ; o] ‘/\_\ 0| Q_(]_\ Seript adanrchcripl o
O Al iorines A Assets - ¥ .. Rigidbody %,
~_ All Scripts
[E] addForceScript Mass 1
At Bray g
» G Editor ) cylinderMaterial Angular Drag 0.05
¥l Standard Assets & Editor Use Gravity
¥ & Character Controll "::::‘:l‘:&"p' Is Kinematic -
]| s e o :
Scripts Particle Script \
Vi Characters & particles ¥ Constraints
¥ il FirstPersonCha rotateCube ¥ lis] [ Particle Script (Script) .
& Audio & standard Assets Script = Particle Script °
il Prefabs @ Transition Out Confetti Emitter "% Confetti (Particle System) C]
& Scripts % triggerScript :
» Gl RollerBall Variables cylinderMaterial %,
QvarsandFuncﬁons [ Shader | Legacy Shaders/Transparent/Diffuse v |

b ThirdPersonCh,




W) il m =8 Center | & Local TR
= Hierarchy # Scene € Game
| Create +| (GoAT ) || | shaded =li2e]] % | < [ & -|] Gizmes ~{ GrAT ) | | oisplay s 2| | Free Aspect
PFPSContmller

Dlrecthnd Lighl

S @3 project

Create [ . YL EY

v

&

Console
| Clear | | Collapse | Clear on Play | Error Pause |

~ | Maximize on Play

[|@o| Ao

- Assets ~

0 All Scripts.

{Is) addForceScript

) cubeMaterial

© cylinderMaterial

&4 Editor
InstantiateScript
materials
materialsScript
Particle Script
pamdes

@ rotateCube

& Standard Assets
Transition Out
triggerScript

les

Q varsandFunctions

0

() Account ¥ Layers v Layout v

® Inspector
Position X 2.2 Y 11475632 0.2
Rotation X -7.486914 Y 0 Z|0
Scale X1 Y 1.147563Z |1
¥ .. Cylinder (Mesh Filter) @ =
Mesh |l Cylinder )
¥ |8 M Capsule Collider 2
co ot
IsTrlgger [

» Materials
Use Light Probes M
Reflection Probes Blend Probes 3
Anchor Override  None (Transform) o
v lis| [ Add Force Script (Script) @
Seript iz addForceScript &
¥ Rigidbody =
‘Mass 1
Angular Drag 0.05
‘Use Gravity ™
Is Kinematic LI
lnurpolm | None ¢
Collision Detection | Discrete Y
¥ Constraints
¥ s M Particle Script (Script) &,
Script: | Particle Script L9
‘Confetti Emitter % Confetti (Particle System) | o
oylinderMaterial &,
[ Shader | Legacy Shaders/Transparent/Diffuse v |




Particle component

Test the mouse button input and interaction
The particle should emit 30 particles on mouse click
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Parent-Child Relationship in Unity
The Child Game Object will inherit the behaviour of its parent
It will move, rotate, scale exactly as its Parent does.

Similar to Arm/Body rleationship- whenever your body moves, your
arm moves along with it

« Thisis a way of grouping objects together

« Children can have their own children and etc.
« Complex parent-child structore

« Represented in the Hierarchy window
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Particle Script - confetii

Add another if statement to add force to push cylinder forward:
public ParticleSystem confettiEmitter;
void Update () {

if (Input.GetButtonDown("Firel1"))

{
confettiEmitter.Emit(30);

}
if (Input.GetKeyDown(KeyCode.Tab))

{
GetComponent<Rigidbody>().AddForce (transform.forward * 200f);

}

CS/DE} Creative Coding Computer Science ® o



Drag and drop Confetti particles inside the Cylinder object in the
Hierarchy window

Test the game
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()
Parenting
@ particles.unity - unity2 - PC, Mac & Linux Standalone (Personal) <OpenGL 4.1>

+ ElIEAIok

= Hierarchy | = € Game
| Create ’l {aral | Shaded 'l |2D | I 0 | <) | d I"l ‘ Gizmos "l ferall ) ||| Display1  #|| Free Aspect ™ | Maximize an Play !
P FPSCaontraller

Directional Light

Plane ‘”

Cube -

v Ciliinder

El consale
Clear | | Collapse | Clear on Play | Error Pause




Unity Documentation - KeyCode

& unity | DOCUMENTATION Manual  Seripting API

Version: 2018.2 (switch to 2018.3b or

ImagePosition Properties

IMECompositionMode

Vo ! ssigned (never returned as the result of a keystroke
JointDriveMode ¢ Not assigned (never returned as the result of a keystroke)
JointLimitState2D Backspace The backspace key
JointProjectionMode ros

Delete The forward delete key.

LegDof

The tab key

“lear ne Cle, o
LightmapBakeType - Thedlearkey.
LightmapsMode Returr Return key
LightmapsModelegacy . 5 :

Pause Pause on PC machines.
LightRenderMode
LightShadowCasterMode £atape Escape key
LightShadows Space Space key.
LightType

Keypad( Numeric keypad 0.
LineAlignment
LineTextureMode Keypad1 Numeric keypad 1.
LocationServiceStatus Keypad2 Numeric keypad 2.
LODFadeMode

Keypad3 Numeric keypad 3.

School of
Design
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Prefalbs and reusable assets

Create Prefab:

« Project > Create > Prefab

« Rename it “PrefabSphere”

« Game Object > 3D > Sphere

* Inspector : Add RigidBody Component
 Drag and drop sphere into PrefabSphere

« Delete Sphere in the Hierarchy window / scene
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Prefabs

£l Console | B3 Project
Create ™ :
Folder iets
g addForceScript
C# Script W cubeMaterial
Javascript :} cylinderMaterial
Editor Test C# Script i Editor
Shader > 3 instantiateScript
{ materials
Scene

materialsScript

Eretal Particle Script

5| rotateCube
Material Standard Assets
Lens Flare = Transition Out
Render Texture triggerScript
Lightmap Parameters 5| Variables

EvarsandFunctions
Sprites | 2

Audio Mixer 4 particles
~

Animator Controller

Animation
v
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particles.unity - unity2 - PC, Mac &

@
(OB S (= B [=cone] S (> F
= Hierarchy | & .= #Scene ) .= [ @ S \ oo 1 E J [ = Center | & Local ]
Create ~| (arAll )|l | Shaded ~l|20 || % | <) | B 7| | Gizmos ~| (oAl -
’;"’SC°:‘"°|"G'" —F Van = Hierarchy ] = HScene
rectional Light \Y/ W = - 558
e -y | Create ~| (arall | Shaded |20 ||
Cube il !
v c:linder ! b FPSController
Confetti Directional Light
Plane
Cube
¥ Cylinder
Confetti
S
' Copy
- ’%ﬁ? Paste
- Rename
Duplicate
[Elconsole | @ Project L @ -= [ cConsole 5 Delete
Create ~ Q I | Clear | | Collapse | Clear on Play | Error
‘i?’_"‘ll Frerdos Al Assets » S I t P f b
Lyt " [i5) addForcescript élect Freia
© cubenareial
>l Editor © cylinderMaterial Create Empty
¥ Standard Assets & Editor :
Vi Character Controllf § ) instantiateScript 3D Ob]ect >
¥l Sources < materials ;
» & PrototypeCha ,@ materialsScript 2D Ob]ect | 4
&l Scripts \Js| Particle Script 5
v Characters P nght >
Vﬁgr:l:;::onchar ‘:'}J oS AU d|0 »
& Prefabs ﬁ Stand.ard Assets ul >
@ scripts i’l.:l ;’;‘t‘r‘;:’:&“' Particle Svst &
» & RollerBall i) article System — .
» i ThirdPersonCha || 1] Variables . ] 4% | o
» il CrossPlatforminpu & varsandFunctions Camera
& PhysicsMaterials o




Instantiate is to create objects during run-time (as the game is
being played)

Instantiate function takes three parameters;
(1) the object we want to create

(2) the 3D position of the object

(3) the rotation of the object
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1. Which object to instantiate?
the best way is to expose a variable

We can state which object to instantiate by using drag and drop to
assign a game object to this variable prefab

2 Where to instantiate it¢

create the new game object to locate new prefab whenever the
Fire2 button is pressed.
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Create Unisinglnstantiate script and assign it to the cilynder:

public class Usinglnstantiate : MonoBehaviour

{
public Rigidbody spherePrefab;

public Transform placetoStart;
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void Update ()

{
if(Input.GetButtonDown("Fire2"))
{
Rigidbody newlnstance;
newlnstance = Instantiate (spherePrefab, placetoStart.position,
placetoStart.rotation);
newlnstance.AddForce(placetoStart.forward * 50);
}
}
Computer Science ic) g‘;:g::“
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Create a new GameObject and assign it as a reference to
Transform placetoStart in the inspector

Assign prefabShpere to spherePrefab in the Inspector

Test the game ad press mouse button 2 to instantiate spheres
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Prefabs




Instantiate- Cleaning Instances

To clean generated prefabs from the scene, aftach the following
script “PrefabDestruction” to the prefabSphere

using UnityEngine;
using System.Collections;

public class PrefabDestruction : MonoBehaviour

{
void Start()

{
Destroy (gameQObject, 5.51);

}
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